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介紹 On Host, On Cell, On Air, On Line, 與 Middle Man等等方式。

錄製手機網路封包的方式01

網際網路IP位址的配發，有相關的資料可以查詢。特別是錄製分析

手機與內部網路的異常正常通訊活動，需要迅速解析IP位址資訊。

解析手機通訊的目標資訊02

各種典型網路封包行為，包括正常瀏覽網站、遊戲程式、電子郵件

等等通訊，也可以發現惡意程式或是異常通訊的封包活動。

常見正常手機的網路通訊03

結合理論與實際操作的網路封包分析，並且討論進一步的學習。

實作與結論04

手機網路封包分析-

基礎篇
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錄製手機網路封包的方式

在網路交換器(Switch)設備，設定Port Mirror或是Y-TAP方式，

從Ethernet擷取TCP/IP網路封包。

WIFI 無線封包 On Line 擷取方式

在 802.11各類通訊電波，使用特殊設備，擷取WEP/WPA 通訊內容。

WIFI 無線封包 On Air 擷取方式

透過特殊設備，在GSM通訊中，從4G/5G訊號，解譯TCP/IP網路封包。

4G/5G 通訊封包 On Cell 擷取方式

在Windows/Linux系統設定『行動熱點』，

採用Wifi繞接Ethernet的方式，擷取TCP/IP網路封包。

WIFI 無線封包 Middle Man 擷取方式

手機 On Host 擷取方式
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錄製手機網路封包的方式
On GSM Cell

ISP局端設備的擷取成本

很高，一般系統無法執

行。

另外有GSM-SIM Card的

解密問題需要克服。

On WIFI Air

使用 AirPCAP的 USB設備，直

接擷取WEP/WPA的802.11封包。

只有 802.11a/b是明碼傳送封包，

可以直接解譯。而802.11g/n則是

需要特殊解密過程, 稱為WEP 

Crack 或是WPA Crack。

On Switch Line

接收各個802.11的頻段，並且在

網路 Switch 設備擷取網路封包。

通常需要設定Port Mirror功能，

或是採用VLAN複製封包方式。

Middle Man

設定行動熱點後，關閉手機GSM

功能，並且開啟WIFI通訊，連接

前述行動熱點，可以跡近無成本。

On Device Host

在智慧手機安裝錄製封包的App

軟體，可以擷取許多特殊網路封

包括TLS加密封包與VPN封包。

Other Approach

除了前述5種方式外，其他擷取網

路封包方式，較為罕見，需要特

別研究。
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常用錄製手機網路封包的方式

用戶端

無線

基地台 網路熱點

網際網路

Internet

D

AirPCAP

網路主機

網路 Switch

用戶端 用戶端

On Switch Line

Middle Man

On Wifi Air
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錄製手機網路封包 -行動熱點

01 這部筆電要同時使用無線與有線的網路通訊，透過

類似轉送封包的方式，完成 Middle Man 機制。

準備Laptop筆電, 要連接 Ethernet

03 這是一個重要而關鍵的動作，在此(Laptop行動熱點)

的情況下，Wireshark的網路卡清單，會多一個網路

項目，要選擇這個新的網路項目，而不能選擇原本

的Wifi網路項目。

啟動Wireshark，指定適當網路卡，擷取封包

05 前述動作皆已完成後，將智慧手機重新啟動，強迫

連接至Laptop筆電的行動熱點，並且觀察Wireshark

的活動紀錄，藉此瞭解手機網路活動有無異常？

手機重新開機，在Laptop筆電檢視其網路活動

02在Windows7以上，可以設定『行動熱點』，並且

將無線網路封包轉換到Ethernet有線網路。

設定 Laptop 無線網路的『行動熱點』

04將智慧手機的GSM功能關閉(取出SIM Card, 或是採

用飛航模式，並開啟無線網路)將此行動設備的無線

網路，重新設定為Laptop筆點的行動熱點名稱。

手機設定連接Laptop筆電的行動熱點
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準備Laptop筆電, 要連接 Ethernet
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設定 Laptop 無線網路的『行動熱點』
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設定 Laptop 無線網路的『行動熱點』
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設定 Laptop 無線網路的『行動熱點』
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啟動Wireshark

指定適當網路卡

擷取封包
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啟動Wireshark

指定適當網路卡

擷取封包
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手機設定連接Laptop筆電的行動熱點
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手機設定連接Laptop筆電的行動熱點
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手機重新開機，

在Laptop筆電檢視其網路活動
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Section Break
實作練習與休息
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解析手機通訊的目標資訊

智慧型手機

手機的OS, App對外通訊的網路活動

網際網路服務

• 網路服務

• 目標 IP 位址

• IP位址的國家與機構

• 不同通訊模式

• 不同通訊內容

Wifi行動熱點

使用Wireshark, Tshark, Tcpdump, Windump

等等工具，擷取智慧手機的網路通訊封包。
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解析手機通訊的目標資訊

使用Google搜尋關鍵字詞：GEOIP Free Download ，尋

找相關網站URL位址, 並下載3個檔案。

下載 GEOIP 資料檔案

在Wireshark的 Edit 功能選單，選擇Preference項

目，選擇 Name Resolution的 MaxMind Database

Wireshark 匯入 GEOIP 資料檔案

匯入3個GEOIP檔案後，重新啟動Wireshark程式

關閉Wireshark後，重新執行

在硬碟建立新目錄，將GEOIP的3個檔案，解壓縮

建立新目錄，放置GEOIP資料檔案

我們為了確定Wireshark 在電腦錄製正確的網路封包，

可以透過先前的DOS介面，輸入PING 168.95.1.1

如果網路有接通，則Wireshark應該會錄製到自己電腦與168.95.1.1的ICMP封包。

重新開始錄製網路封包
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(1) 第一步，尋找並下載 GEOIP 資料庫
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(1) 第一步，尋找並下載 GEOIP 資料庫
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(1) 第一步，尋找並下載 GEOIP 資料庫

GEOIP檔案, 下載的三大要點:

1. 下載格式 Format -> GeoIP2 Binary格式

2. 下載檔案 Download -> GZIP檔案

3. 分別下載 GeoLite2-ASN, GeoLite2-City, 

GeoLite2-Country

GEOIP檔案, 下載的三大要點:

1. 下載格式 Format -> GeoIP2 Binary格式

2. 下載檔案 Download -> GZIP檔案

3. 分別下載 GeoLite2-ASN, GeoLite2-City, 

GeoLite2-Country
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解壓縮檔案，到新目錄

23

(2) 第二步，建立新目錄，解壓縮 GEOIP 資料庫檔案

GEOIP檔案, 解壓縮的要點:

1. 必須個別解出目錄 ASN, City, Country

2. 每個目錄都要有相關的 mmdb檔案

3. 分別是 GeoLite2-ASN.mmdb, GeoLite2-

City.mmdb, GeoLite2-Country.mmdb
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(3) 第三步，設定Wireshark 匯入 GEOIP 資料檔案

Wireshark 匯入 GEOIP檔案的要點:

1. Windows 系統的Wireshark, 在 Edit -> Preferences -> Name Resolution

2. 在對話視窗的右下角, 有 MaxMind Database 的 Edit 按鍵

3. 在新出現的對話視窗, 分別加入 GeoLite2-ASN, GeoLite2-City, GeoLite2-Country 目錄

4. MaxOS系統的 Wireshark, 在Wireshark -> Preferences -> Name Resolution (其餘步驟，與 2, 3 相
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(3) 第三步，設定Wireshark 匯入 GEOIP 資料檔案

(4) 第四步，設定匯入 GEOIP 資料後,

關閉程式後，再重新啟動Wireshark
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實作題目 (範例操作)

請使用 PING 指令，測試

168.95.1.1 的網路連線，同

時錄製其網路封包。

亦即 PING 168.95.1.1

錄製Hinet的網路封包

請使用 PING 指令，測

試 www.google.com 的

網路連線，同時錄製其

網路封包。

亦即 PING 

www.google.com

錄製Google的網路封包
請使用 PING 指令，測

試 www.microsoft.com 

的網路連線，同時錄製

其網路封包。

亦即 PING 

www.microsoft.com

錄製微軟的網路封包
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擷取過濾與顯示

過濾的使用方式

請同學練習錄製自己電腦本機封包，確定

能夠錄製到對外網路通訊的封包。

擷取過濾與顯示

過濾的使用方式

中華民國網路封包分析協會



10100110100100001010
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etwor k

Traffic FiltersN
Wireshark

有2種過濾條件

(1) 擷取過濾 Capture Filter

(2) 顯示過濾 Display Filter

如果沒有適當的封包擷取過濾條件

(Capture Filter)，錄製網路封包的時候，會造

成大量封包。在時效上，封包分析的工作可

能會窒礙難行。另外一方面，若是封包顯示

過濾條件(Display Filter) 設定不適當，則可能

會造成封包篩選結果誤判，導致分析結論產

生錯誤。

不論是哪種過濾條件，對分析人員來說，

都必須瞭解這些過濾條件的作用與影響。

原則: 越寬鬆越好

一般來說，在資訊安全與鑑識的立場，如果不

是關於APT攻擊、網路蠕蟲、電腦病毒、木馬程

式的問題，通常只要忽略廣播封包(Broadcast) 

與群播封包 (Multicast) 即可。

擷取過濾條件 (Capture Filter)
原則: 越精確越好

這個過濾設定，是在擷取網路封包後，進行

個案分析的時候，郵分析人員輸入的封包過濾

條件。依照案件特性與分析者的經驗，會有不

同的顯示過濾條件。為了能有效找出網路安全

問題，這個過濾條件，越精準越好。

顯示過濾條件 (Display Filter)

Network 

Traffic
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善用過濾條件，加強分析效率
同時使用 Capture Filter 與 Display Filter

• Capture Filter 是用於網路卡擷取網路封包的時候，就發生效用的過濾條件。要非常謹慎使用，以避免漏失網路封包。

• Display Filter  是用於已經擷取後的網路封包，進行各種分析，用來找出影響資訊安全的網路封包。特別要注意的是，

網路活動的互動行為，例如DNS與HTTPS的互動、網路芳鄰的連接互動、ARP與TCP的互動等等。不同的網路互動過

程，就如同程式執行的網路行為一樣，可以看出許多異於正常的通訊行為，此為異常程式通訊行為分析的基本觀念。
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在功能選單，選取 Capture 的 Options 項目，會出現這個對話視窗

擷取過濾條件 Capture Filter
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在功能選單，選取 Analyze 的 Display Filters 項目，會出現這個對話視窗

顯示過濾條件 Display Filter

Display Filter 基本語法

• 欄位名稱 == 數值或字串

• 欄位名稱 in {數值 數值 數值 “字串”}

• 欄位名稱 contains “字串”

• 欄位名稱 matches “正規表示字串”

• 可以使用 and 或 or 或 not

• 可以使用 && 或 || 或 !

• 可以使用 ( 與 )

• 可以使用 > 或 < 或是 >= 或 <=
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Display Filter 常用欄位與範例

網路 IP 位址欄位

• ip.addr

• ip.src

• ip.dst

• ipv6.addr

網路通訊埠欄位

• tcp.port

• tcp.srcport

• tcp.dstport

網路通訊協定欄位

• arp

• dns

• http

• tls

網路封包內容

• tcp contains “字串”

• tcp matches “Perl 正規字串”

• tcp matches “(?i)s.e.l.e.c.t” 中華民國網路封包分析協會



ip.addr == xxx.xxx.xxx.xxx

ip.addr == xxx.xxx.0.0/16

Ip.src == xxx.xxx.0.0/16

顯示特定 IP 位址的通訊01

ip.addr != xxx.xxx.xxx.xxx

not ip.addr == xxx.xxx.xxx.xxx

忽略特定 IP 位址的通訊02

tcp.port == 80

http

顯示特定 TCP/UDP Port 通訊03

tcp.port != 80

not tcp.port == 80

not http

忽略特定 TCP/UDP Port通訊04

顯示過濾條件範例
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tcp.port in {80 443}

tcp.port in {80 8000 8080 10000}

顯示多個 TCP/UDP Port 通訊05

Ip.addr== C&C中繼站位址 and tcp.port in {80 443}

Ip.addr!=192.168.x.x/16 and tcp.port in {139 445}

顯示特定IP位址與特定Port通訊06

dns or http or tcp.port in {80 443} or tls

udp.port==53 or tcp.port in {80 8000 8080 10000}

觀察DNS與HTTP/HTTPS互動07

(tcp contains “MZ” and  tcp contains “PE”) and ftp

tcp contains “MZ” and (http or tcp.port in {80 8000} )

觀察特定通訊的封包內容08

顯示過濾條件範例
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ip.geoip.asnum==15169

ip.geoip.org==“GOOGLE“

ip.geoip.asnum in {8068 8075}

顯示特定機構(公司) 通訊09

ip.geoip.country=="Taiwan“

ip.geoip.city=="Tokyo"

顯示特定國家(城市) 通訊10

tcp.flags.syn==1

tcp.flags.syn==1 or tcp.flags.fin==1 or 

tcp.flags.reset==1

顯示 TCP 通訊連線或斷線11

(smb or smb2) and (ip.addr!=10.10.0.0/16)

(tcp.port in {139 445} ) and (ip.addr!=10.10.0.0/16)

網路芳鄰異常連接到外網電腦12

顯示過濾條件範例

(tcp.port in {139 445} ) and (not ((ip.src==10.10.0.0/16) and (ip.dst==10.10.0.0/16)))
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擷取過濾與顯示過濾的使用方式

基本過濾條件是: 忽略廣播封包與群播封包

Capture Filter: not broadcast and not multicast

設定擷取過濾條件 Capture Filter

記得, 要選擇正確有線網路卡或是Wifi無線卡

開始錄製網路封包

1.先在cmd.exe裡面，執行 PING 168.95.1.1

2.瀏覽 https://www.nspa-cert-tw.org/網站

開啟網頁瀏覽器, 瀏覽特定網站

這個動作，是為方便執行 PING 指令，產生封包

準備DOS程式介面，預備執行命令列

雖然我們不知道目標網站的IP位址，但是, 

因為先前的DOS介面，已經輸入PING 168.95.1.1

並且, 使用 HTTPS 瀏覽這個網站 www.nspa-cert-tw.org所以顯示過濾條件可以設定為:

display filter: icmp or dns or (tcp.port==443 and tcp.flags.syn==1)

輸入顯示過濾條件 Display Filter

中華民國網路封包分析協會
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實作題目 (範例操作)

錄製 ping 

www.microsoft.com 封包，

並且根據微軟的機構代碼

(ORG ID) 為 8068與8075，

設定顯示過濾條件，同時過

濾(顯示)本機對微軟機構的

通訊封包。

顯示連線微軟的網路封包

由於Ethernet網路卡對

於網路資料的傳送，網

卡位址(MAC Address) 

是做基本的資料，並且

透過ARP封包行為可以

取得這個網卡位址資

料。

顯示ARP封包 (內網活動)
請設定顯示過濾條件，

將不是台灣的外網通訊，

全部顯示出來。

特別注意，只要對

外部網路的通訊封包，

要忽略內部網路互傳的

通訊封包。

顯示非台灣的網路封包
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匯出網路通訊

封包資料檔案

請同學預先練習錄製自己電腦本機封包，

確定能夠錄製到自己對外網路通訊的封包。

匯出網路通訊

封包資料檔案
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匯出網路通訊封包資料檔案

過濾後的網路封包，還需要各種判讀技巧(Skills)這些技巧，也就是異常網

路封包的判讀經驗累積後，得到的判讀通則，並能引導我們尋找威脅網路

安全的通訊封包段落。

3. 過濾後的封包，尋找有無資安問題的段落

Skills

一般來說，在企業內部網路錄製網路封包，通常網路封包數量會非常大，

這些原始封包資料(Raw Data)同時包括各式各類通訊行為(下載、電郵、

ERP等等)，因此要找出威脅網路安全的通訊封包，需要許多技巧，不然

會徒勞無功。

1. 原始封包數量龐大，內容複雜

Raw 

Data

我們將這些有問題的通訊段落，單獨儲存為網路封包檔案，也就是匯出為獨

立的網路封包檔案，以利於後續報告整理與威脅研判的用途。

4. 將有資安問題的封包，匯出成為獨立檔案

Export

透過擷取過濾條件(Capture Filter)與顯示過濾條件(Display Filter)的協助，

我們可以去蕪存菁，找到異常通訊行為(不符合正常工作的通訊行為)

2. 針對網路資安問題，擷取過濾適當封包
Filters
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不論那種封包工具，PCAP檔案格式，是所有作業系統的通用封包格式。

PCAP檔案格式，同時考慮作業系統與數值資料的 Hi-Byte, Low-Byte問題，支援Unix, 

Windows, Linux, iOS等等系統，是一種網路封包的通用檔案格式。

匯出網路通訊封包

資料檔案

網路封包數量越多，越難以分析。原則上要

降低網路封包數量，就需要控制這五個變數:

• 電腦數量 (Active Hosts Count)

• 網路頻寬 (Bandwidth)

• 行為複雜度 (Network Behavior)

• 錄製時間 (Capture Time Range)

• 擷取過濾條件 (Capture Filter)

封包數量與電腦機台數量、網路頻寬、

網路行為量、錄製時間成正比

找出資安問題封包的方式，除了自動化機制

之外，剩下的方式就是:

• 顯示過濾條件 (Display Filter)

• 特定行為模式 (Network Behavior)

• 豐富判讀經驗 (Skills and Experience)

過濾分析，精確匯出資安問題封包
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在功能選單，選取 File 的 Export Specified Packets 項目，會出現這個對話視窗

顯示過濾條件 Display Filter

剩下的封包數量
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匯出網路通訊的封包資料檔案

先關閉所有通訊程式，包括遊戲程式、網頁瀏覽

器、電郵程式、與任何已知通訊程式。

準備錄製網路封包

應該是有線網路卡或是Wifi無線卡

在 Wireshark 選擇適當網路卡

在顯示過濾條件(Display Filter) 設定 icmp過濾條件

設定顯示過濾條件

這個動作，是為方便執行 PING 指令，產生封包

準備DOS程式介面，預備執行命令列

我們為了確定Wireshark 在電腦錄製正確的網路封包，

可以透過先前的DOS介面，輸入PING 168.95.1.1

如果網路有接通，則Wireshark應該會錄製到自己電腦與168.95.1.1的ICMP封包。

接著，我們可以直接設定顯示過濾條件(Display Filter) 不必停止錄封包，就可以顯示封包內容有

ICMP的網路活動。停止網錄錄製後，便可以直接匯出過濾後的網錄封包。

匯出特定(過濾後)網路封包檔案
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實作題目 (範例操作)

錄製 ping 

www.microsoft.com 封

包，並且根據微軟的機構

代碼(ORG ID) 為 8068與

8075，設定顯示過濾條

件，同時過濾(顯示)本機

對微軟機構的通訊封包。

匯出連線微軟的網路封包

長時間紀錄ARP封包行

為，可以取得網卡位址

資料。同時，也能夠取

得，同一個Switch的網

路設備清單，藉此可以

瞭解內網設備。

匯出ARP封包 (內網活動)

請設定顯示過濾條件，

將不是台灣的外網通訊，

全部顯示出來。

特別注意，只要對外

部網路的通訊封包，要

忽略內部網路互傳的通

訊封包。

匯出非台灣的網路封包
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命令列模式的封包分析

這個參數，告訴Wireshark/Tshark要讀取的 PCAP 封包檔案名稱

-r 輸入封包檔案資料

如同GUI介面，適當的顯示過濾條件可以用來快速篩選我們要的封包資料，

而 -R 是Wireshark 使用, -Y 是 Tshark使用。條件字串可以使用 “ 與 “ 框

列起來。

-R 或 –Y  顯示過濾條件

針對 Tshark來說，將符合過濾條件的封包資料，另外儲存成為新封包檔

案, 適合作為大量封包分析的批次作業方式，動作類似GUI介面的

Wireshark的Export Special Packets 匯出特殊封包功能。

-w 重新儲存檔案名稱

適合大量分析作業的方式

(1) Wireshark    (2) TShark     (3) Python

一般來說，不論使用哪種方式，要注意三個關鍵，作為命令列操作的參

數。

特別注意參數大小寫字母的差異!!
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常見的正常網路

封包範例

請同學開啟各個正常範例封包檔案，確定

能夠顯示正常網路通訊封包的檔案目錄。

常見的正常網路

封包範例
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NSPA Skills – Web Browse Behavior-連接(瀏覽)網站網頁(加密)
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NSPA Skills – Web Browse Behavior-連接(瀏覽)網站網頁(明碼)
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NSPA Skills – Web Browse Behavior-網頁檔案擷取完成-1
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NSPA Skills – Web Behavior – Windows 擷取天氣資訊
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NSPA Skills – Web Browse Behavior-網頁檔案擷取完成-2
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NSPA Skills – Web Browse Behavior-網頁檔案連續擷取
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NSPA Skills – Web Browse Behavior-網頁檔案擷取完成(斷線)
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NSPA Skills – Web Browse Behavior-網頁檔案擷取完成(斷線)
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NSPA Skills – FTP Behavior – FTP 匿名登入
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NSPA Skills – Telnet Behavior
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NSPA Skills – SMB/CIFS - Activity
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NSPA Skills – SMTP
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NSPA Skills – Windows VPN - Initialize
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Smart Phone 網路封包範例
以下是智慧手機的範例封包，由於各種作業系統的網路行為不同，再加上

不同版本的手機型號，自行修改原生系統的程式內容。同時，多樣的手機

應用程式App版本，也影響其網路封包活動。

我們觀察的重點，可以聚焦在以下的主要項目：

04

02
這些次序僅左為執行Process的參考，而非絕對。

出現目標IP位址的次序

01
可以先忽略Google的IP位址, 以減少負擔。

目標通訊的IP位址與國家資訊

03 特別是不明目標位址的週期反覆行為，與連線失敗通

訊的嘗試行為，都屬於異常的網路行為模式。

反覆出現的通訊行為

使用者沒有操作App, 確有相關通訊會傳送出去，這是

需要特別注意的網路活動之一。

特殊通訊服務與無App操作的背景通訊
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NSPA Skills – Smart Phone – Android(Galaxy-8)
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NSPA Skills – Smart Phone – Android(Galaxy-10)
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NSPA Skills – Smart Phone – Android(Sugar)
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常見的異常網路

封包範例

請同學開啟各個異常範例封包檔案，確定

能夠顯示異常網路通訊封包的檔案目錄。

常見的異常網路

封包範例
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NSPA Skills – Cycle Period Connection –固定時間循環行為-1

更多分析技巧，請參考 http://www.nspa-cert.org and  https://www.nspa-cert-tw.org/中華民國網路封包分析協會

http://www.nspa-cert.org/
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NSPA Skills – Mass SYN Connection – Port Scan

更多分析技巧，請參考 http://www.nspa-cert.org and  https://www.nspa-cert-tw.org/中華民國網路封包分析協會
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NSPA Skills – Mass SYN Connection – Port Scan

更多分析技巧，請參考 http://www.nspa-cert.org and  https://www.nspa-cert-tw.org/中華民國網路封包分析協會
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NSPA Skills – Mass SYN Connection – Malware Infection

更多分析技巧，請參考 http://www.nspa-cert.org and  https://www.nspa-cert-tw.org/中華民國網路封包分析協會
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NSPA Skills – Mass SYN Connection – P2P Initialize
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NSPA Skills – Mass RST ACK – Port Scan

(Firewall Rejected)

更多分析技巧，請參考 http://www.nspa-cert.org and  https://www.nspa-cert-tw.org/中華民國網路封包分析協會
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NSPA Skills – Download Malware –偽裝於HTTP的惡意下載過程
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NSPA Skills – Web Behavior – Web CGI Scanning
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NSPA Skills – Web Behavior – SQL Injection
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NSPA Skills – Malware Infected –連接C&C Host 的失敗-1
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NSPA Skills – Malware Infected –連接C&C Host 的失敗-2
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NSPA Skills – Relay Behavior –連接C&C Host
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NSPA Skills – DNS Spoofing – DNS 異常行為
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NSPA Skills – ARP Spoofing –網路竊聽竊密行為
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NSPA Skills – SMB Malware –透過網路芳鄰的惡意程式感染
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NSPA Skills – SMB Malware –透過網路芳鄰的惡意程式感染
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NSPA Skills – SMB Malware –透過網路芳鄰的惡意程式感染
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NSPA Skills – SMB Abnormal –透過網路芳鄰的異常網路行為
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NSPA Skills – SMB Abnormal –透過網路芳鄰的異常網路行為
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NSPA Skills – SMB Abnormal –透過網路芳鄰的密碼攻擊
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評量與討論
中華民國網路封包分析協會

NSPA/NTPA

http://www.nspacert.org

http://www.ntpa.org.tw

http://www.nspa-cert-tw.org

http://www.huge-diamond.net
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THANK YOU
中華民國網路封包分析協會 NSPA/NTPA
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